


Introduction

You made the right choice twice: OS X El Capitan (OS X

10.11) and this book. Take a deep breath and get ready

to have a rollicking good time. That’s right. This is a

computer book, but it’s fun. What a concept! Whether

you’re brand spanking new to the Mac or a grizzled Mac

vet, I guarantee that reading this book to discover the

ins and outs of OS X El Capitan will make everything

easier. The publisher couldn’t say as much on the cover if

it weren’t true!

About This Book

This book’s roots lie with my international best seller

Macintosh System 7.5 For Dummies, an award-winning

book so good that long-deceased Mac clone-maker Power

Computing gave away a copy with every Mac clone it

sold. OS X El Capitan For Dummies is the latest revision

and has been, once again, completely updated to include

all the tasty OS X goodness in El Capitan. In other words,

this edition combines all the old, familiar features of

previous editions — but is once again updated to reflect

the latest and greatest offering from Apple as well as

feedback from readers.

Why write a For Dummies book about El Capitan? Well,

El Capitan is a big, somewhat complicated personal-

computer operating system. So I made OS X El Capitan

For Dummies a not-so-big, not-too-complicated book that

shows you what El Capitan is all about without boring

you to tears, confusing you, or poking you with sharp

objects.



In fact, I think you’ll be so darned comfortable that I

wanted the title to be OS X El Capitan Made Easy, but

the publishers wouldn’t let me. Apparently, we For

Dummies authors have to follow some rules, and using

For Dummies in this book’s title is one of them.

And speaking of dummies — remember, that’s just a

word. I don’t think you’re a dummy at all — quite the

opposite! My second choice for this book’s title was OS X

El Capitan For People Smart Enough to Know They Need

This Book, but you can just imagine what Wiley thought

of that. (“C’mon, that’s the whole point of the name!”

they insisted. “Besides, it’s shorter our way.”)

The book is chock-full of information and advice,

explaining everything you need to know about OS X in

language you can understand — along with timesaving

tips, tricks, techniques, and step-by-step instructions, all

served up in generous quantities.

Another rule we For Dummies authors must follow is that

our books cannot exceed a certain number of pages.

(Brevity is the soul of wit, and all that.) So I wish I could

have included some things that didn’t fit. Although I feel

confident you’ll find what you need to know about OS X

El Capitan in this book, some things bear further looking

into, including these:

Information about many of the applications

(programs) that come with OS X El Capitan: An

installation of OS X El Capitan includes roughly 55

applications, mostly located in the Applications folder

and the Utilities folder within it. I’d love to walk you

through each one of them, but that would have

required a book a whole lot bigger, heavier, and more

expensive than this one.



I brief you on the handful of bundled applications

essential to using OS X El Capitan and keep the focus

there — namely, Calendar, Contacts, Messages, Mail,

Safari, TextEdit, and the like — as well as several

important utilities you may need to know how to use

someday.

Information about Microsoft Office, Apple

lifestyle and productivity apps (iMovie,

Numbers, Pages, and so on), Adobe Photoshop,

Quicken, and other third-party applications:

Okay, if all the gory details of all the bundled (read:

free) OS X El Capitan applications don’t fit here, I think

you’ll understand why digging into third-party

applications that cost extra was out of the question.

Information about programming for the Mac:

This book is about using OS X El Capitan, not writing

code for it. Dozens of books — most of which are two

or three times the size of this book — cover

programming on the Mac; this one doesn’t.

Conventions Used in This

Book

To get the most out of this book, you need to know how I

do things and why. Here are a few conventions I use in

this book to make your life easier:

When I want you to open an item in a menu, I write

something like Choose File ⇒ Open, which means, “Pull

down the File menu and choose the Open command.”

Stuff you’re supposed to type appears in bold type,

like this.



Web addresses and things that appear onscreen are

shown in a special monofont typeface, like this. (If

you’re reading an e-book version of this book, web

addresses are clickable links.)

For keyboard shortcuts, I write something like +A,

which means to hold down the  (Command) key and

then press the A key on the keyboard.

Foolish Assumptions

Although I know what happens when you make

assumptions, I’ve made a few anyway. First, I assume

that you, gentle reader, know nothing about using OS X

— beyond knowing what a Mac is, that you want to use

OS X, that you want to understand OS X without having

to digest an incomprehensible technical manual, and that

you made the right choice by selecting this particular

book. And so I do my best to explain each new concept in

full and loving detail. Maybe that’s foolish, but … that’s

how I roll.

Oh, and I also assume that you can read. If you can’t,

ignore this paragraph.

Beyond the Book

I have written a lot of extra content that you won’t find in

this book. Go online to find the following:

Cheat Sheet: www.dummies.com/cheatsheet/osxelcapitan

Additional articles:

www.dummies.com/extras/osxelcapitan

Updates to this book, if any:

www.dummies.com/extras/osxelcapitan

http://www.dummies.com/cheatsheet/osxelcapitan
http://www.dummies.com/extras/osxelcapitan
http://www.dummies.com/extras/osxelcapitan


Icons Used in This Book

Little round pictures (icons) appear off to the left side of

the text throughout this book. Consider these icons

miniature road signs, telling you a little something extra

about the topic at hand. Here’s what the different icons

look like and what they all mean.

 Look for Tip icons to find the juiciest morsels:

shortcuts, tips, and undocumented secrets about El

Capitan. Try them all; impress your friends!

 When you see this icon, it means that this

particular morsel is something that I think you

should memorize (or at least write on your shirt cuff).

 Put on your propeller-beanie hat and pocket

protector; these parts include the truly geeky stuff.

It’s certainly not required reading, but it must be

interesting or informative, or I wouldn’t have wasted

your time with it.

 Read these notes very, very, very carefully. (Did I

say very?) Warning icons flag important cautionary

information. The author and publisher won’t be

responsible if your Mac explodes or spews flaming

parts because you ignored a Warning icon. Just

kidding. Macs don’t explode or spew (with the

exception of a few choice PowerBook 5300s, which



won’t run El Capitan anyway). But I got your

attention, didn’t I?

 These icons represent my ranting or raving about

something that either bugs me or makes me smile.

When I’m ranting, imagine foam coming from my

mouth. Rants and raves are required to be

irreverent, irrelevant, or both. I try to keep them

short, for your sake.

 Well, now, what could this icon possibly be about?

Named by famous editorial consultant Mr. Obvious,

this icon highlights all things new and different in OS

X El Capitan.

Where to Go from Here

The first few chapters of this book are where I describe

the basic things that you need to understand to operate

your Mac effectively. If you’re new to Macs and OS X El

Capitan, start there.

OS X El Capitan is only slightly different from previous

Mac operating systems, and the first part of the book

presents concepts so basic that if you’ve been using a

Mac for long, you might think you know it all — and okay,

you might know most of it. But remember that not-so-old-

timers need a solid foundation, too. So here’s my advice:

Skim through stuff you already know and you’ll get to

the better stuff sooner.



 I would love to hear how this book worked for you.

So please send me your thoughts, platitudes, likes

and dislikes, and any other comments. Did this book

work for you? What did you like? What didn’t you

like? What questions were unanswered? Did you

want to know more (or less) about something? Tell

me! I have received more than 100 suggestions

about previous editions, many of which are

incorporated here. So please (please!) keep up the

good work! Email me at

ElCapitan4Dummies@boblevitus.com. I appreciate your

feedback, and I try to respond to all reasonably polite

email within a few days.

So what are you waiting for? Go! Enjoy the book!

http://ElCapitan4Dummies@boblevitus.com/


Part I

Introducing OS X El

Capitan: The Basics

 Visit www.dummies.com for great For Dummies content

online.

http://www.dummies.com/


In this part …

 In the beginning: The most basic of basics including

how to turn on your Mac

 A gentle introduction to the El Capitan Finder and its

Desktop

 Your Dock: Making it work harder for you

 Everything you need to know about El Capitan’s

windows, icons, and menus (oh my)!

 All the bad puns and wisecracks you’ve come to

expect

 A plethora of Finder tips and tricks to make life with El

Capitan even easier (and more fulfilling)



Chapter 1

OS X El Capitan 101

(Prerequisites: None)

In This Chapter

 Understanding what an operating system is and is

not

 Turning on your Mac

 Getting to know the startup process

 Turning off your Mac

 Avoiding major Mac mistakes

 Pointing, clicking, dragging, and other uses for your

mouse

 Getting help from your Mac



Congratulate yourself on choosing OS X, which stands

for (Mac) Operating System X — and that’s the Roman

numeral ten, not the letter X (pronounced ten, not ex).

You made a smart move because you scored more than

just an operating system (OS) upgrade. OS X El Capitan

includes several new features that make using your Mac

easier and dozens of improvements under the hood that

help you do more work in less time.

In this chapter, I start at the very beginning and talk

about OS X in mostly abstract terms; then I move on to

explain what you need to know to use OS X El Capitan

successfully.

If you’ve been using OS X for a while, most of the

information in this chapter may seem hauntingly

familiar; a number of features that I describe haven’t

changed from previous versions of OS X. But if you

decide to skip this chapter because you think you have

all the new stuff figured out, I assure you that you’ll miss

at least a couple of things that Apple didn’t bother to tell

you (as if you read every word in OS X Help — the only

user manual Apple provides — anyway!).

Tantalized? Let’s rock.

 One last thing: If you’re about to upgrade to El

Capitan from an earlier version of OS X, you might

want to peruse the article on installing and

reinstalling El Capitan in full and loving detail, found

at www.dummies.com/extras/osxelcapitan.

Gnawing to the Core of OS

X

http://www.dummies.com/extras/osxelcapitan


The operating system (that is, the OS in OS X) is what

makes a Mac a Mac. Without it, your Mac is a pile of

silicon and circuits — no smarter than a toaster.

“So what does an operating system do?” you ask. Good

question. The short answer is that an OS controls the

basic and most important functions of your computer. In

the case of OS X and your Mac, the operating system

Manages memory

Controls how windows, icons, and menus work

Keeps track of files

Manages networking and security

Does housekeeping (No kidding!)

Other forms of software, such as word processors and

web browsers, rely on the OS to create and maintain the

environment in which they work their magic. When you

create a memo, for example, the word processor

provides the tools for you to type and format the

information and save it in a file. In the background, the

OS is the muscle for the word processor, performing

crucial functions such as the following:

Providing the mechanism for drawing and moving the

onscreen window in which you write the memo

Keeping track of the file when you save it

Helping the word processor create drop-down menus

and dialogs for you to interact with

Communicating with other programs

And much, much more (stuff that only geeks could

care about)



So, armed with a little background in operating systems,

take a gander at the next section before you do anything

else with your Mac.

One last thing: As I mention in this book’s Introduction

(I’m repeating it here only in case you normally don’t

read introductions), OS X El Capitan comes with more

than 50 applications. Although I’d love to tell you all

about each and every one, I have only so many pages at

my disposal.

 The Mac advantage

Most of the world’s personal computers use Microsoft Windows (although

more and more people are switching to the Mac). But you’re among the

lucky few to have a computer with an OS that’s intuitive, easy to use, and

(dare I say?) fun. If you don’t believe me, try using Windows for a day or two.

Go ahead. You probably won’t suffer any permanent damage. In fact, you’ll

really begin to appreciate how good you have it. Feel free to hug your Mac.

Or give it a peck on the disc drive slot (assuming that your Mac has one;

most, including the MacBook, MacBook Air, and Mac mini at this writing,

don’t). Just try not to get your tongue caught.

As someone once told me, “Claiming that OS X is inferior to Windows

because more people use Windows is like saying that all other restaurants

serve food that’s inferior to McDonald’s.”

We might be a minority, but Mac users have the best, most stable, most

modern all-purpose operating system in the world, and here’s why: Unix, on

which OS X is based, is widely regarded as the best industrial-strength

operating system on the planet. For now, just know that being based on Unix

means that a Mac running OS X will crash less often than an older (pre-OS X)

Mac or a Windows machine, which means less downtime. Being Unix-based

also means getting far fewer viruses and encounters with malicious

software. But perhaps the biggest advantage OS X has is that when an

application crashes, it doesn’t crash your entire computer, and you don’t

have to restart the whole computer to continue working.

By the way, since the advent of Intel-powered Macs a few years ago, you can

run Windows natively also on any Mac powered by an Intel processor, as I

describe in Chapter 17. Note that the opposite isn’t true: You can run

Windows on your Mac if you like, but you can’t run OS X on a Dell or HP (or



any other computer not made by Apple) without serious hacking (which is

technically illegal anyway).

And don’t let that Unix or Windows stuff scare you. It’s there if you want it,

but if you don’t want it or don’t care (like most of us), you’ll rarely even

know it’s there. In fact, you’ll rarely (if ever) see the word Unix or Windows

again in this book. As far as you’re concerned, Unix under the hood means

your Mac will just run and run and run without crashing and crashing and

crashing. As for Windows, your Mac can run it if you need it; otherwise, it’s

just another checklist item on the list of reasons Macs are better.

A Safety Net for the

Absolute Beginner (or Any

User)

In the following sections, I deal with the stuff that OS X

Help doesn’t cover — or doesn’t cover in nearly enough

detail. If you’re a first-time Macintosh user, please,

please read this section of the book carefully; it could

save your life. Okay, okay, perhaps I’m being overly

dramatic. What I mean to say is that reading this section

could save your Mac or your sanity. Even if you’re an

experienced Mac user, you may want to read this section.

Chances are you’ll see at least a few things you’ve

forgotten that will come in handy now that you’ve been

reminded of them.

Turning the dang thing on
Okay. This is the big moment — turning on your Mac!

Gaze at it longingly first, and say something cheesy, such

as, “You’re the most awesome computer I’ve ever

known.” If that doesn’t turn on your Mac (and it probably

won’t), keep reading.

Apple, in its infinite wisdom, has manufactured Macs

with power buttons on every conceivable surface: on the



front, side, and back of the computer itself, and even on

the keyboard and monitor.

So if you don’t know how to turn on your Mac, don’t feel

bad; just look in the manual or booklet that came with

your Mac. It’s at least one thing that the documentation

always covers.

 These days, most Macs have a Power button near the

keyboard (notebooks) or the back (iMacs). It usually

looks like the little circle thingy you see in the margin.

 Don’t bother choosing Help ⇒ Mac Help, which

opens the Help Viewer program. It can’t tell you

where the switch is. Although the Help program is

good for finding out a lot of things, the location of

the power button isn’t among them. If you haven’t

found the switch and turned on the Mac, of course,

you can’t access Help anyway. (D’oh!)

What you should see on startup
When you finally do turn on your Macintosh, you set in

motion a sophisticated and complex series of events that

culminates in the loading of OS X and the appearance of

the OS X Desktop. After a small bit of whirring, buzzing,

and flashing (meaning that the OS is loading), OS X first

tests all your hardware — slots, ports, disks, random

access memory (RAM), and so on. If everything passes,

you hear a pleasing musical tone and see the tasteful

whitish Apple logo in the middle of your screen, as

shown in Figure 1-1.



Figure 1-1: This is what you’ll see if everything is fine and dandy when you turn

on your Mac.

Here are the things that might happen when you power-

up your Mac:

Fine and dandy: Next, you might or might not see

the OS X login screen, where you enter your name

and password. If you do, press Return after you type

your name and password, of course, and away you go.

 If you don’t want to have to type your name and

password every time you start or restart your Mac (or

even if you do), check out Chapter 17 for the scoop on

how to turn the login screen on or off.

Either way, the Desktop soon materializes before your

eyes. If you haven’t customized, configured, or

tinkered with your Desktop, it should look pretty

much like Figure 1-2. Now is a good time to take a

moment for positive thoughts about the person who

convinced you that you wanted a Mac. That person

was right!



Blue/black/gray screen of death: If any of your

hardware fails when it’s tested, you may see a blue,

black, or gray screen.

Some older Macs played the sound of a horrible car

wreck instead of the chimes, complete with crying

tires and busting glass. It was exceptionally

unnerving, which might be why Apple doesn’t use it

anymore.

 The fact that something went wrong is no

reflection on your prowess as a Macintosh user.

Something is broken, and your Mac may need repairs.

If this is happening to you right now, check out

Chapter 20 to try to get your Mac well again.

 If your computer is under warranty, set up a

Genius Bar appointment at your nearest Apple Store

or dial 1-800-SOS-APPL, and a customer service

person can tell you what to do. Before you do

anything, though, skip ahead to Chapter 20. It’s

entirely possible that one of the suggestions there can

get you back on track without your having to spend

even a moment on hold.

 Prohibitory sign (formerly known as the

“flashing question mark on a disk”): Most users

eventually encounter the prohibitory sign shown in the

left margin (which replaced the flashing question-

mark-on-a-disk icon and flashing folder icon back in OS

X Jaguar). This icon means that your Mac can’t find a

startup disk, hard drive, network server, or DVD-ROM



containing a valid Macintosh operating system. See

Chapter 20 for ways to ease your Mac’s ills.

Kernel panic: You shouldn’t see this very often, but

you may occasionally see a block of text in six

languages, including English, as shown in Figure 1-3.

This means that your Mac has experienced a kernel

panic, the most severe type of system crash. If you

restart your Mac and see this message again, look in

Chapter 20 for a myriad of possible cures for all kinds

of ailments, including this one.

Figure 1-2: The OS X El Capitan Desktop after a brand-spanking-new

installation of OS X.



Figure 1-3: If this is what you’re seeing, things are definitely not fine and

dandy.

 How do you know which version of the Mac OS

your computer has? Simple:

1. Choose About This Mac from the  menu (the

menu with the  symbol in the top-left corner of

the menu bar).

A window pops up on your screen, as shown in Figure

1-4. The version you’re running appears just below OS

X El Capitan near the top of the window. Version

10.11 is the release we know as El Capitan.

 If you’re curious or just want to impress your

friends, OS X version 10.10 was known as Yosemite;

10.9 was known as Mavericks; 10.8 as Mountain Lion;

10.7 as Lion; 10.6 as Snow Leopard; 10.5 as Leopard;

10.4 as Tiger; 10.3 as Panther; 10.2 as Jaguar; 10.1 as

Puma; and 10.0 as Cheetah.



2. (Optional) Click the Overview, Displays, Storage,

Support, or Service tabs to see additional

information about your Mac and the version of

OS X that it’s running.

3. Click the System Report button to launch the

System Information application and see even

more details.

The System Information app shows you even more

about your Mac including bus speed, number of

processors, caches, installed memory, networking,

storage devices, and much more. You can find more

about this useful program in Chapter 19.

Figure 1-4: See which version of OS X you’re running.

Shutting down properly
Turning off the power without shutting down your Mac

properly is one of the worst things you can do to your

poor Mac. Shutting down your Mac improperly can really



screw up your hard or solid-state drive, scramble the

contents of your most important files, or both.

 If a thunderstorm is rumbling nearby, or you’re

unfortunate enough to have rolling blackouts where

you live, you may really want to shut down your Mac

and unplug it from the wall. (See the next section,

where I briefly discuss lightning and your Mac.)

To turn off your Mac, always use the Shut Down

command from the  menu or shut down in one of these

kind-and-gentle ways:

Press the Power button for approximately two seconds

and then click the Shut Down button in the Are You

Sure You Want to Shut Down Your Computer Now?

dialog.

On keyboards that don’t have a Power key, press

Control+Eject instead, and then click the Shut Down

button that appears in the Are You Sure You Want to

Shut Down Your Computer Now? dialog.

 You can use a handy keyboard shortcut when

the Shut Down button (or any button, for that matter)

is highlighted in blue and pulsating slightly. Pressing

the Return key is almost always the same as clicking a

highlighted button.

The Are You Sure You Want to Shut Down Your Computer

Now? dialog sports a check box option in OS X El

Capitan: Reopen Windows When Logging Back In. If you

select this check box, your Mac will start back up with

the same windows (and applications) that were open

when you shut down or restarted. I think that’s pretty



darn sweet, but you can clear this option if that’s not

what you want!

Most Mac users have been forced to shut down

improperly more than once without anything horrible

happening, of course — but don’t be lulled into a false

sense of security. Break the rules one time too many (or

under the wrong circumstances), and your most

important files could be toast. The only time you should

turn off your Mac without shutting down properly is

when your screen is completely frozen or when your

system crashed due to a kernel panic and you’ve already

tried everything else. (See Chapter 20 for what those

“everything elses” are.) A really stubborn crash doesn’t

happen often — and less often under OS X than ever

before — but when it does, forcing your Mac to turn off

and then back on might be the only solution.

Eternally yours … now

OS X is designed so that you never have to shut it down. You can configure it

to sleep after a specified period of inactivity. (See Chapter 17 for more info

on the Energy Saver features of OS X.) If you do so, your Mac will consume

very little electricity when it’s sleeping and will usually be ready to use

(when you press any key or click the mouse) in a few seconds. On the other

hand, if you’re not going to be using it for a few days, you might want to

shut it down anyway.

Note: If you leave your Mac on constantly, and you’re gone when a lightning

storm or rolling blackout hits, your Mac might get hit by a power surge or

worse. So be sure you have adequate protection — say, a decent surge

protector designed specifically for computers — if you decide to leave your

Mac on and unattended for long periods. See the section “A few things you

should definitely not do with your Mac,” elsewhere in this chapter, for more

info on lightning and your Mac. Often as not, I leave it on when I’m on the

road so that I can access it from my laptop via remote screen sharing. So,

because OS X is designed to run 24/7, I don’t shut it down at night unless the

night happens to be dark and stormy.

One last thing: If your Mac is a notebook and will be enclosed in a bag or

briefcase for more than a few hours, turn it off. Otherwise, it could overheat

— even in Sleep mode.



A few things you should definitely

not do with your Mac
In this section, I cover the bad stuff that can happen to

your computer if you do the wrong things with it. If

something bad has already happened to you … . I know,

I’m beginning to sound like a broken record, but see

Chapter 20.

Don’t unplug your Mac when it’s turned on. Very

bad things can happen, such as having your OS break.

See the preceding section, where I discuss shutting

down your system properly.

Note that this warning doesn’t apply to laptops as

long as their battery is at least partially charged. As

long as there’s enough juice in the battery to power

your Mac, you can connect and disconnect its power

adapter to your heart’s content.

Don’t use your Mac when lightning is near.

Here’s a simple life equation for you: Mac + lightning

= dead Mac. ’Nuff said. Oh, and don’t place much

faith in inexpensive surge protectors. A good jolt of

lightning will fry the surge protector and your

computer, as well as possibly frying your modem,

printer, and anything else plugged into the surge

protector. Some surge protectors can withstand most

lightning strikes, but those warriors aren’t the

cheapies that you buy at your local computer

emporium. Unplugging your Mac from the wall during

electrical storms is safer and less expensive. (Don’t

forget to unplug your external modem, network hubs,

printers, and other hardware that plugs into the wall

as well; lightning can fry them, too.)



For laptops, disconnect the power adapter and all

other cables because whatever those cables are

connected to could fry and fry your laptop right along

with it. After you do that, you can use your laptop

during a storm if you care to. Just make sure that it’s

100 percent wireless and cableless if you do.

Don’t jostle, bump, shake, kick, throw, dribble,

or punt your Mac, especially while it’s running.

Many Macs contain a hard drive that spins at 5,200

revolutions per minute (rpm) or more. A jolt to a hard

drive while it’s reading or writing a file can cause the

head to crash into the disk, which can render many —

or all — files on it unrecoverable. Ouch!

 Don’t think you’re exempt if your Mac uses a

solid-state drive with no moving parts. A good bump

to your Mac could damage other components. Treat

your Mac like it’s a carton of eggs, and you’ll never be

sorry.

Don’t forget to back up your data! If the files on

your hard drive mean anything to you, you must back

up. Not maybe. Must. Even if your most important file

is your last saved game of Bejeweled, you still need to

back up your files. Fortunately, El Capitan includes an

awesome backup utility called Time Machine.

(Unfortunately, you need either an external hard drive

or an Apple Time Capsule device to take advantage of

it.) So I beg you: Please read Chapter 18 now, and find

out how to back up before something horrible

happens to your valuable data!

 I strongly recommend that you read Chapter 18

sooner rather than later — preferably before you do



any significant work on your Mac. Dr. Macintosh says,

“There are only two kinds of Mac users: Those who

have lost data and those who will.” Which kind do you

want to be?

Don’t kiss your monitor while wearing stuff on

your lips. For obvious reasons! Use a clean, soft cloth

and/or OmniCleanz display cleaning solution (I love

the stuff, made by RadTech; www.radtech.us) to clean

your display.

 Don’t use household window cleaners or paper

towels. Either one can harm your display. Use a soft

clean cloth (preferably microfiber), and if you’re going

to use a cleaner, make sure it’s specifically designed

not to harm computer displays. Finally, spray the

cleaner on the cloth, not on the screen.

Point-and-click boot camp
Are you new to the Mac? Just figuring out how to move

the mouse around? Now is a good time to go over some

fundamental stuff that you need to know for just about

everything you’ll be doing on the Mac. Spend a few

minutes reading this section, and soon you’ll be clicking,

double-clicking, pressing, and pointing all over the place.

If you think you have the whole mousing thing pretty

much figured out, feel free to skip this section. I’ll catch

you on the other side.

Still with me? Good. Now for some basic terminology:

Point: Before you can click or press anything, you

have to point to it. Place your hand on your mouse,

and move it so that the cursor arrow is over the object

you want — like on top of an icon or a button.
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If you’re using a trackpad, slide your finger lightly

across the pad until the cursor arrow is over the

object you want.

Click: Also called single click. Use your index finger

to push the mouse button all the way down and then

let go so that the button (usually) produces a

satisfying clicking sound. (If you have one of the

optical Apple Pro mice, you push the whole thing

down to click.) Use a single click to highlight an icon,

press a button, or activate a check box or window.

In other words, first you point and then you click —

point and click, in computer lingo.

If you’re using a trackpad, press down on it to click.

Double-click: Click twice in rapid succession. With a

little practice, you can perfect this technique in no

time. Use a double-click to open a folder or to launch

a file or application.

Trackpad users: Press down on the pad two times in

rapid succession.

Control-click: Hold down the Control key while

single-clicking. (Also called secondary-click or right-

click.)

Trackpad users can either hold down the Control key

while pressing down on the pad with one finger, or by

tapping the trackpad with two fingers without holding

down the Control key.

If tapping your trackpad with two fingers didn’t bring

up the little menu, check your Trackpad System

Preferences pane (see Chapter 5).

Control-clicking — the same as right-clicking a

Windows system — displays a menu (called a

contextual or shortcut menu). In fact, if you’re blessed

with a two-or-more-button mouse (such as the Apple



Magic Mouse), you can right-click and avoid having to

hold down the Control key. (You may have to enable

this feature in the Mouse System Preference pane.)

Drag: Dragging something usually means you have to

click it first and hold down the mouse or trackpad

button. Then you move the mouse on your desk or

mouse pad (or your finger on the trackpad) so that the

cursor and whatever you select moves across the

screen. The combination of holding down the button

and dragging the mouse is usually referred to as

clicking and dragging.

 Wiggle (or jiggle): This welcome

improvement, introduced in El Capitan (and terrific if

I do say so myself) is awesome when you lose track of

the pointer on your screen. Just wiggle your mouse

back and forth (or jiggle your finger back and forth on

the trackpad) for a few seconds and the pointer will

magically get much bigger, making it easier to see on

the screen. And, of course, when you stop wiggling or

jiggling, the pointer returns to its normal size.

Choosing an item from a menu: To get to OS X

menu commands, you must first open a menu and

then choose the option you want. Point at the name of

the menu you want with your cursor, press the mouse

button, and then drag downward until you select the

command you want. When the command is

highlighted, finish selecting by letting go of the mouse

button.

 If you’re a longtime Mac user, you probably hold

down the mouse button the whole time between



clicking the name of the menu and selecting the

command you want. You can still do it that way, but

you can also click the menu name to open it, release

the mouse button, point at the item you want to

select, and then click again. In other words, OS X

menus stay open after you click their names, even if

you’re not holding down the mouse button. After you

click a menu’s name to open it, you can even type the

first letter (or letters) of the item to select it and then

execute that item by pressing the spacebar or the

Return key. Furthermore, menus remain open until

you click something else.

Go ahead and give it a try … I’ll wait.

 The terms given in the preceding list apply to all

Mac laptop, desktop, and tower systems. If you use a

MacBook, MacBook Pro, MacBook Air, or Apple

Magic Trackpad, however, there are a few more

terms — such as tap, swipe, rotate, pinch, and

spread — you’ll want to add to your lexicon. You can

read all about them in full and loving detail in

Chapter 4.

Not Just a Beatles Movie:

Help and the Help Menu

One of the best features about all Macs is the excellent

built-in help, and OS X El Capitan doesn’t cheat you on

that legacy: This system has online help in abundance.

When you have a question about how to do something,

the Help Center is the first place you should visit (after

this book, of course).



Clicking the Help menu reveals the Search field at the

top of the menu and the Mac Help and New to Mac

items. Choosing Mac Help opens the Mac Help window,

as shown in Figure 1-5; choosing New to Mac launches

Safari and displays a tour of OS X El Capitan.

Figure 1-5: Mac Help is nothing if not helpful.

 Though the keyboard shortcut for Help no long

appears on the Help menu, the same shortcut as

always, Shift+ +?, still opens Help.

You can browse Help by clicking a topic in the Table of

Contents and then clicking a subtopic. If you don’t see

the Table of Contents, click the Table of Contents button

as shown in Figure 1-5.


